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James H. Lee, Jr., President 
of Tropical Software will 
make his second visit to 
LIMac in May, and he’s 
hoping for better weather 
this trip. (If you remember 
our 2005 Holiday Party 
you’ll remember that the 

weather was not exactly hos-
pitable.) This time he’s got even more to show 
us. In addition to TopXNotes he’ll show us the 
new TopXNotes iPod.

TopXNotes began as a brand new twist on 
that old favorite, the old Apple Notepad, but 
TopXNotes has evolved to be much, much more. 
It has all the basic functionality of your word 
processor, including choice of fonts, style, and 
colors. TopXNotes’ unique features include: 
MultiView, the ability to view many notes at 
once; the NoteOrganizer, an advanced table 
of contents with categories and groups you 
define based on your information; and most 
popular, QuickNotes, the ability to access your 
key notes instantly from the desktop from a 
menu in a floating toolbar or from the same 
menu in the dock. TopXNotes also features auto-
matic backups, unlimited Undo, Find, and note 
encryption to keep sensitive information safe.

TopXNotes iPod is a modern note organizer 
with all the useful features of TopXNotes  plus 
the ability to export selected notes and groups 

This month, 
we had a 
really great 
presentation 
by Justin 
D’Onofrio, 
and Steven 
Tze, from 

Freeverse software, 
located in New York City. You may 

know Freeverse from the Burning Monkey 
games. Justin handled the microphone, while 
veteran illustrator Steven, demonstrated the 
program. This made for a super-smooth
 presentation.

Lineform, is a vector-based drawing pro-
gram, made for both the graphic artist, and the 
average computer user. It sports a simple inter-
face and small tool set. This makes it easier for 
those new to drawing programs and those with 
experience using other programs, but are new 
to Lineform. In case you are not familiar with 
the term “vector based,” it means that once you 
have your project completed, it can be resized 
with no loss in quality. 

OK, you have just chosen a tool, and are 
not sure what to do with it, or how to perform 
certain functions with it, there’s no problem 

–Lineform’s built-in help menus to the rescue! 
What is a built-in Help Menu? Just click on a 
tool, and instructions on how to use the tool, 
and its modifier keys, appear directly under the 
tool bar. This is the first time I have seen this, 
and it really helps. Want to add text to make 
a flyer? Lineform has robust text editing tools, 
everything is dynamic (can be modified at any 
time) and all of the text tools, (color, size, etc.) 
built into Mac OS X are available. 

If you are like me, (not an artist) you can 
make your drawings look a lot better – easily 

– with Lineform.
You really had to be there to see Justin and 

Steve demonstrate the program, or go to www.
freeverse.com, download the demo, and see for 
yourself. 

At $79.95, this is a powerful program that 
will not overwhelm a new user, but will make a 
savvy graphics user quite happy. 

Many thanks to Justin and Steve, for a really 
great presentation. 0 

–Scott Randell
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General meeting time schedule:
Meetings are held at The New York Institute of Technology,
Building 300 (Anna Rubin Hall), Old Westbury, Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m.
Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m.
followed by announcements and raffle drawings.
SIG (Special Interest Group) meetings 8:30–10:00 p.m.
Photoshop SIG: Photoshop CS 2 – Layers
Multimedia SIG: “How to tell a story in a home video” from expert Al Zygier. 
MacBasics SIG: Taking an introductory look at the iLife package, consisting 

of GarageBand, iDVD, iMovie HD, iPhoto, 
and iWeb. What can we use them for? What 
sort of fun can be found in this versatile 
package?
| In bad weather, call (516) 686-7789.
| The next LIMac board meeting will be at 
the Plainedge Library, (516) 735-4133, 
on Wednesday, Mayl 18th, at 8 p.m.  
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Bill Medlow
President
ArchBill@optonline.net

| What is Flash?
This used to be Macromedia’s technology, 
now it’s Adobe’s (because Adobe bought 
Macromedia) for interactive animated multi-
media content for web sites and cell phones. 
There is the now-shipping $700 Flash CS3 
Professional to create flash files and there is the 
free Flash Player 9 Internet plug-in for your 
Web browsers. Both were just updated for the 
Mac. There is also the companion to Flash 
Pro CS3 the Flash CS3 Video Encoder. Its only 
purpose is for converting your movie files, say 
in QuickTime.mov format into an flv flash video 
format for use in sites like the very popular 
YouTube.com Beyond Flash, there is also the 
new $499-$7.49 Adobe Flex Builder 2 inte-
grated design environment for creating flash-
based Rich Internet Applications. It is not part 
of any Adobe Creative Suite 3 bundle. It’s based 
on the Open Source Eclipse 3.2 software develop-
ment kit which is itself based on Sun’s Java code. 
Flash-enhanced Web sites are becoming more 
commonplace as Web developers go beyond 
what is possible with just HTML. As an end-
user, the only thing to watch out for is to the 
proper version of the new 9.0.45.0 version of 
Adobe Flash Player for Intel-based or the older 
PowerPC-based Macs running OS X. This new 
release support the new ActionScript 3.0 from 
Adobe Flash CS3. 
| I’m going to have my hard drive replaced 
and I’ve already backed up my documents. I 
know there is my Applications folder in the 
sidebar, but what is in there – and should I 
back up the Apple apps as well as the ones 
I’ve added? I’d like to be able to restore my 
laptop to the same state as before. 
You should backup everything to make it easier 
to put everything back. If you do things piece-
meal, then something always falls through 
the cracks and gets lost. A bootable FireWire 
external hard drive with a clone of your entire 
hard drive, would allow you to overwrite the 
new hard drive with just the original Apple 
software with everything you had before, 
right down to the dock and desktop and every 
update and preference intact. After the restora-
tion the external drive becomes your backup 
drive. Anyway, if you click the Applications 
icon in the sidebar, it opens the window for 
(Q&A continues on Page 3.)

Once again, I need to give you a “heads up” on 
our upcoming June 2007 general meeting.

It will be on the second Friday in June, – 
specifically, June 8th, but we have moved the 
meeting location to C.W.Post (1/4 mile east) 
for this meeting only. Maps will be on the back 
of the monthly poster and on our Web site. We 
will in meet the Humanities Building, just in 
from the Tilles Center.

Why all the fuss you ask? We will have Dave 
Marra, an Apple Senior Systems engineer, to 
talk about all the new things coming from 
Apple. As we know, Apple has changed its name 
from Apple Computer to Apple Inc. and has 
increased its product line to include other prod-
ucts such as the iPod, the Apple TV and the 
upcoming iPhone.

I am mostly interested in how these prod-
ucts work and integrate with our Macintosh 
computers. Dave will offer information and 
insight in all things Apple. Aside from making 
so many things possible, the Macintosh also 
makes them more fun. 0

(Continues on Page 3)

(March’s Meeting continues from Page 1)
to iPod. In addition to all of the above features 
also found in TopXNotes , TopXNotes  iPod can 
export a subset of your notes (designated by 
you) and the enclosing group hierarchy (also 
created by you) to your iPod. The result is that 
your notes are organized the same way on your 
iPod and your Mac.

Mac OS X 10.3 (Panther) or higher is required 
for TopXNotes iPod. TopXNotes iPod also 
requires a newer (3rd generation or newer) iPod. 
Apple has not used the informal “generations” 
terminology and it is not easy to learn about. 
However, if an iPod has an LCD and Dock con-
nector, and the Apple Notes Reader is installed, 
it should work. According to Apple, the Notes 
feature is available on iPod models with a dock 
connector including: iPod mini, iPod with 
color display (iPod photo), iPod (Click Wheel), 
iPod (with Dock Connector), iPod nano and 
iPod with video.

Of course, there’ll be our usual Q&A, raffle 
and SIGs, so make sure to mark your calendar 
for this month’s informative and interesting 
meeting. 

–Rick Matteson

Redefine paragraph 
styles in Adobe 
InDesign CS2:
If you need to 
make changes to a 
Paragraph Style, you 
could double-click 
on the style listing in 
the Paragraph Styles 
palette and then 
make the changes 
in the multi-tabbed 
dialog that opens. 
You can even check 
a preview box in the 
lower left hand corner 
of the window to see 
each of the changes 
update.

But there is a 
way that seems a lot 
more intuitive. You 
simply reformat one 
paragraph that has 
the Paragraph Style 
applied to it. Then, 
with the text cursor 
anywhere in the refor-
matted text, go under 
the Options menu of 
the Paragraph Styles 
palette and select 
Redefine Style. This 
applies your format-
ting changes in this 
one paragraph to all 
paragraphs that have 
the style applied.  

 TIP!

Remembering the 
last point size used 
in Adobe InDesign 
CS2 :
You just resized the 
headline in an ad 
to 76 points (a size 
that’s not listed as 
a Preset in the Point 
Size popup menu 
in the Character 
palette). You open 
another layout (File 
> ) and you’d like to 
make its 72-point 
headline the exact 
same size as in the 
first ad. Now what 
was that size? If you 
go to the Point Size 
Preset menu, 76 
points is magically 
listed at the top of 
the Presets menu. 
The last point size you 
used (or selected) 
that’s not a Preset 
will always be listed 
at the top of the 
Presets menu. It 
will remain in the 
listing until you use 
or select type that’s 
another point size 
not listed in Presets, 
or until you Quit the 
application.

–Jeff Witchel 
Certified Adobe 
Training Provider.

About Meetup and LIMac:
By George Canellis
Meetup.com helps people find others 
who share their interest or cause, and 
form lasting, influential, local community 
groups that regularly meet face-to-face. 
We believe that the world will be a better 
place when everyone has access to a 
people-powered local Meetup Group. 
That’s our goal.

Meetup Groups help people:
 | Find others who share their interests
| Get involved locally
| Learn, teach, and share things
| Make friends and have fun
| Rise up, stand up, unite,& make a difference
| Be a part of something bigger — both locally 
and globally

We’re proud to give more power to the people 
and we believe it’s possible to make a profit and 

make a difference.
Meetup.com earns money from:
| Meetup Groups who rely on us to help them 
create great Meetups and great local groups
| Partner organizations that use Meetup.com 
services to grow and strengthen their com-
munities
| Sponsors who buy unobtrusive text ads rel-
evant to Meetup Group members
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 TIPS!
Fix embedded
media in Safari:
QuickTime: To 
fix a QuickTime-
related problem 
with Safari, quit 
Safari and look in 
the/Library/Internet 
Plug-ins folder (this 
is the Library folder 
at the root level of 
your hard drive, not 
the one inside your 
Users/username/ 
folder). Try removing 
the VLC Plugin.plugin 
(if you have it) and 
QuickTime Plugin.
plugin files from this 
folder (start with any 
third-party plugins 
that are present), 
and then, relaunch 
Safari. If the problem 
isn’t fixed, a differ-
ent plugin may be 
to blame, keep 
removing files from 
this folder (start 
with any third-party 
programs that are 
present) until the 
problem disappears. 
Replace the plug-ins 
that don’t cause any 
problems.
Flash: The most 
common Flash 
problem is that the 
audio doesn’t work, 
usually caused by 

(Q&A continues onPage 6)

an erroneous Audio 
Output setting. Here’s 
the fix:
1. launch Audio MIDI 
Setup (/Applications/
Utilities).
2. Click the Audio 
Devices tab at the top 
of the window.  
3. In the Properties 
For pull-down menu, 
select Built-In Audio.
4. Change the Audio 
Output>Format set-
ting to 44100.0Hz.
5. Quit Audio MIDI 
Setup.
6. Quit and relaunch 
Safari.
Rosetta: If you have 
an Intel-based Mac, 
running Safari in 
Rosetta can also 
resolve some plug-in 
issues.

First, quit the app 
if it’s open, and then, 
in your Applications 
folder, select Safari 
and press Command-
l. In the General area 
of the Safari Info 
dialog that appears 
(click the disclosure 
triangle if this 
area is not already 
expanded), select 
Open Using Rosetta, 
and then close the 
Safari Info Dialog. 
Relaunch Safari. 

–Mac|Life Magazine

the Applications folder on your hard drive 
where, presumably, all your Apple provided 
and 3rd-party applications are installed, at least 
the bulk of them. Many applications include 
parts elsewhere on your hard drive, in your 
Library folder and your Home folder’s Library 
sub-folder. It would be a daunting task to 
back up a bit here and there on a pile of CDs 
or DVDs and try to put everything back cor-
rectly. Particularly so as many folders are larger 
than even a DVD holds, so breaking things up 
becomes a problem. Toast 7 and 8 can backup 
large amounts of data that span many discs 
and includes on the first disc a program that 
can put it all back together, but a hard drive of 
adequate size is so much faster and easier. I’ve 
been suggesting the 3-year limited warranty 
blessed silvery plastic Western Digital My Book 
Pro Edition drives with FireWire 800, 400 and 
USB 2.0 interfaces. Not to be confused with the 
black 1-year warranty Premium or Essential 
Editions. $148, $230 or $379 for 250 GB, 500 
GB or 1 TB sizes at amazon.com. LaCie’s brand 
desktop drives have been getting a lot of bad 
feedback lately about faulty and under powered 
power adapters, so I don’t recommend their 
full-size desktop hard drives. Their FireWire 
bus-powered mobile hard drives (80 to 160GB) 
are good. Nevertheless, it’s a good idea to also 
backup your critical files onto CD or DVD to be 
sure. 
| Scott Randell suggested a Seagate bare 
drive and an external enclosure to take 
advantage of Seagate’s 5-year warranty on 
their internal drives. 
As much I do like 5-year warranties and Seagate, 
most people don’t want to assemble and format 
their own external drives. Anyway, back to the 
problem at hand, once you have some external 
hard drive available, preferably hooked up via 
FireWire, to make a bootable copy, you need 
some software like the freeware Carbon Copy 
Cloner or LaCie’s SilverKeeper or the $28 
shareware SuperDuper! By the way, LaCie not 
long ago started offering the Universal Binary 
1-Click Backup Software version 1.1.1, but this 
application does not make a bootable copy. 
Then, once you get your laptop back, use the 
program to clone back your files. 
| I’ve been using Apple’s iWeb to create 
a Web site with music and video and pic-

tures. Some people can’t see it. Does that 
mean I should include a link to download 
QuickTime to see the movies? 
Depends on what format the videos and music 
are in. Obviously in the format they are in now 
– yes. If you converted the movies to .avi format 
and the music to .mp3 (iWeb can accommodate 
these formats) that would be better cross-plat-
form, as both Macs and Windows can use them 
out-of-the-box. When you drag an .mp3 format 
onto the page, it’s treated like a QuickTime 
movie with a placeholder for a picture. Still it 
should work better, I should think, but if it 
doesn’t, then give up and include a link to www.
apple.com/quicktime/download/. Windows Vista 
users don’t have a solution, nor do Windows 98 
or Me or NT users, just Windows 2000 and XP 
can install QuickTime 7, but Windows 98/Me 
users can install QuickTime 6.4, so that may 
help. Point them to http://docs.info.apple.com/
article.html?artnum=120297 or QuickTime 6.3 for 
Windows NT at http://docs.info.apple.com/article.
html?artnum=120261 Have you tried the $40 
RapidWeaver from realmac Software? It’s easy 
and similar to iWeb (“themes” based templates) 
and works with a .Mac account. 
| I have an external hard drive and I want 
iPhoto to use it. Do I have to install OS X on 
the external drive?
No need to install OS X again. iPhoto itself has 
no option for pointing to a non-standard library 
folder, but you can use the free iPhoto Librarian 
1.2 from Scruffy Software to help. Get it at www.
scruffyware.com/products/iPhotoLibrarian.
html. You can command-drag (to move not 
just copy) your existing “iPhoto Library” in 
your ~/Pictures/ folder to the external drive and 
then use the iPhoto Librarian Applescript to 
Choose…, navigate to the iPhoto Library folder 
and with it selected, click the Choose button 
and then start up iPhoto and everything should 
be fine from then on, at least until you need to 
change the location again. 
| I already have images on the external 
drive. Can I drag them in the moved iPhoto 
Library folder?
No. You should drag them into the iPhoto 
window when it’s running in order to properly 
import any files. In order to avoid any future 
duplications of images you drag in, you can go 

More of Bradley’s Tech Session 

“A convenient, non-threatening way to connect to 
other people who share similar interests and live 
nearby.” Time

“…helps groups of strangers organize monthly 
powwows at local watering holes.” Newsweek

“…it’s important to stay true to your passions or 
interests, whatever they may be… An opportu-
nity to reconnect with yourself and others in a 
stress-free environment. It’s as simple as that.” 

Toronto Sun
Opening? Saving? Spotlight Is There
Okay, it’s time to save a file, so you choose Save 
As and the typical Save dialog appears. You want 
to save your document in a particular folder, but 
you can’t remember exactly where that folder 
is. No sweat, because Spotlight lives in the Save 
(and Open) dialog as well (it’s everywhere!). Just 
type the name of the folder you’re looking for in 
the Spotlight field in the upper right-hand corner 

of the Save As dialog and all the folders with that 
name appear in your Save window, so you can get 
right where you want blindingly fast. Nice.
Sending Huge Attachments
Most e-mail servers have a limit to how large an 
attachment they’ll accept. Most limit an attach-
ment size to 5MB (some even less), and if you e-
mail somebody a 6MB file, it’s probably going to 
get “kicked back” to you as undeliverable. Want 
to get around that? Use iChat instead. Once you 

have an iChat session started with someone, 
you can go under the Buddies menu and choose 
Send File. Navigate your way to the file you want 
to send, click OK, and the file will be sent to the 
person you’re chatting with (and a link to down-
load your file will appear in their iChat window). 
No matter how big the file size is, it’ll get there.
Is That Task Done Yet? The Dock Knows
Let’s say you’re working in a power-crunching app 
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LIMac is a proud member of the Peachpit user 
Group Partner Program and as such all LIMac 
members are entitled to a 30% discount off of  
the list price of any of Peachpits books. When 
ordering at their Web site (www.peachpit.com) 
at checkout, right before you enter your credit 
card number, you must enter the user group 
coupon code ue-23AA-PeuF (case-sensi-
tive). This coupon code is an exclusive offer 
that may not be used in conjunction with any 
other coupon codes. Through the generosity 
of Peachpit, LIMac will also be receiving free 
books as raffle prizes. Look for them on the 
prize table when youre purchasing your raffle 
tickets at the monthly meeting.

The following vendor offers require a top-
secret user group offer code. If you are inter-
ested in any of the following products, please 
send an e-mail to me at gwc11713@optonline.net.
| Prosoft is dedicated to creating professional 

quality software designed to be easily used by 
both novice and expert users. Prosoft adopts 
the role of being data advocates, fighting to pre-
serve data and prevent data loss. Prosoft offers a 
25% discount to all MuGs using the special 
MuG discount code. Their products include: 
Drive Genius – Maintain, Manage and 
Optimize Your Hard Drive; Picture Rescue – 
Digital Picture recovery; Data Backup – 
Backup Made easy; Data Rescue – emergency 
File recovery; and TuneTech for iPod – 
Maintain, Manage and Optimize your iPod. 
(www.prosofteng.com)
| MUG members can now take 30% off a single 
book or 35% off two or more books from 
O’reilly, No Starch, Paraglyph, PC Publishing, 
Pragmatic Bookshelf, SitePoint, or Syngress 
books you purchase directly from O’reilly. 
(www.oreilly.com/store)

like Photoshop, and you go to apply a filter to a 
high-res image, and it’s going to take a minute 
or two to process your command. You’re going to 
get a progress bar so you can see how long the 
process is going to take, right?

Well, thanks to Mac OS X’s way-cool Dock, 
you can switch out of Photoshop to work on 
something else and the Dock will let you know 
when the filter is applied. How? Well, when a 

progress bar appears in Photoshop, the Dock 
automatically adds a tiny little progress bar to 
the bottom of the Photoshop icon in the Dock so 
you can keep an eye on the progress, even when 
you’re doing something else (like checking your 
mail, shopping online, or writing a letter).
Saving Spotlight Searches
Spotlight also lives in your Finder windows (right 
where the old Search field was in previous ver-
sions of Mac OS X), but when you search here, 

you get a little bonus — avable searches.
So, for example, you search for all the e-mail, 

images, and other junk sent to you by your friend 
Alan. When you do this in a Finder window, the 
Finder window updates to show the results right 
there in your window. Oh, but there’s more. Now 
you’ll find a Save button near the top-right side 
of your window. If you click it, it saves your results 
in a folder in your sidebar, where you can re-
access those files at any time. How cool is that!

 But this is no ordinary folder, my friend. This is 
a Smart Folder, which means the next time Alan 
sends you something (or you mention Alan in a 
document, e-mail, etc.), it will automatically be 
added to that Smart Folder. It’s live, baby!
Printing from the Desktop
(without a Desktop Printer)
Don’t want a printer icon cluttering up your 
desktop, but you still want to print files from 
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Helen and
Sheldon Gross
shel9@verizon.net

Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

Well, we’re back from China, after having taken 
about 1000 pictures by actual count. even after 
we discard those we’re unhappy with, we’ll still 
have many hundreds to play with. We traveled 
with the laptop, and the job every evening was 
to download the day’s photos and then empty 
the camera for the next day. We found this tech-
nique most feasible for our purposes.

First order of business was adapting all our 
electrical appliances to Chinese electrical con-
nections. Of course we had the converters for 
this purpose, but it’s hard to use only one con-
verter when you need to recharge organizers, 
batteries, blackberries, computers and other 
assorted incidentals. It was a life saver to find 
out that the nicer hotels had at least one outlet 
that was a 110-line, in addition to all the 220-
lines in the room.

The next issue was the Internet. All the 
hotels and airports claimed to have wireless 
and/or ethernet connections, but the opera-
tive word is often ‘claimed.’ Sometimes they 
had wireless, but you needed a login name 
and a password. Occasionally, the wireless was 
so weak that it didn’t work in the rooms. All 
the hotels seemed to have business offices, but 
most were not staffed by anyone who could 
explain the intricacies of the system in english. 

      Sore Eyes
Occasionally, the wireless was provided by T-
Mobile and you had to join (and pay money) to 
use it. Some hotels, although not all, also added 
an extra charge for Internet service.

The most surprising, however, was the 
difficulties with e-mail. We have an ISP pro-
vided by Verizon and usually try to get our e-
mail from their Web site when away from home. 
Often the Apple Mail program cannot send 
e-mail, since the outgoing mail server will not 
be recognized by the particular hotel network. 
But China is having a dispute with Verizon, so 
they don’t even let you traverse the Verizon site. 
When we entered the site in Firefox, it would go 
to the home page, but not actually enter the site. 
Logging-in was impossible. We could pick up 
our mail with Apple Mail but not send it with 
Verizon. We could only send our mail through 
Google and/or Yahoo, but they worked fine for 
that purpose.

I really don’t know if other people with 
other ISP companies had a similar problem, 
since I was not able to converse with any others 
on this topic. My Cantonese is non-existent and 
my Manderin consists of one phrase – ‘sia sia’ 
which means ‘thank you.’

At any rate, we had a wonderful time and are 
still working on the slideshows. 0

User Group NewsGeorge Canellis
gwc11713@optonline.
net
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It’s tempting to format outgoing e-mail with 
different fonts, point sizes and colors, and 
to punch up your 
text with the use of 
italics and boldface. 
unfortunately, what you 
send is not necessarily 
what your recipient gets.

Some e-mail pro-
grams don’t read special 
formatting, including fonts that your reader’s 
computer doesn’t have. And many allow the 
user to set preferences for plain text instead of 
rich text, which includes styling. The result: 
your carefully formatted e-mail is reduced to 
plain text, or worse, littered with ‘alien’ charac-
ters (more on that below).

What’s the solution? First, stick to system 
fonts, such as Arial, Times, Verdana, Trebuchet 
or Geneva, which virtually all users have. And, 
unless you’re certain that the recipient can read 
your formatting, keep it simple and use only 
keyboard characters and styling that won’t 
get lost in translation. For emphasis, try sur-
rounding your important text with *asterisks.* 
ALL CAPS is another option, but one to be used 
sparingly. remember that CAPS are considered 
SHOuTING in the cyberworld!

For most people who have access to personal 
computers, e-mail has rapidly overtaken ‘snail 
mail’ as the preferred means of sending written 
communication, both business and personal. 
The near-immediate delivery and low cost of 
e-mail are hard to beat, but the technology does 
have limitations when it comes to typographic 
finesse. Here are some dos and don’ts to ensure 
that your electronic communication is received 
with its message intact.
Safe Characters

One of the most puzzling occurrences in 
e-mails is the occasional appearance of strange, 
unfamiliar characters in the text, often foreign 
or mathematical in nature. We can usually read 
around them, but even so, what are they and 
how did they get there?

This can occasionally happen to non-stan-
dard keyboard characters when they’re sent 
from one e-mail program to another. These 
characters include such typographic niceties 
as ‘smart’ quotes and apostrophes, en and em 
dashes, and bullets. These characters and others 

like them are not always encoded or trans-
lated consistently from one e-mail program to 

another. The result? 
Your carefully for-
matted curly quotes, 
ligatures and ellipses 
can turn into some-
thing unrecognizable 
to your recipient’s 
inbox.

The solution is simple: play it safe and stick 
to the standard keyboard characters (see illus-
tration above). While this means using ‘dumb’ 
straight quotes and double hyphens instead of 
correct dashes, at least your message will arrive 
in a readable form. (But don’t forget: when 
copying and pasting text from an e-mail into a 
designed piece for print, reformat these ‘dumb’ 
characters to adhere to the principles of good 
typography!)
Signatures and Attachments

Other points of good e-mail etiquette 
include using a signature and being savvy about 
attachments. A signature is a short block of copy 
that identifies you and includes your contact 
information. Most e-mail programs allow you 
to set up one or more signatures to choose 
from, or to select a default signature that will 
automatically appear at the bottom of every 
e-mail you send. usually used for business, 
signatures can be a great time-saver if you use 
them appropriately. remember to include your 
signature in each subsequent e-mail to the same 
recipient so no one has to search for the e-mail 
with your phone number. Another tip: don’t 
include images and logos in your signature. 
These are often filtered out by spam filters and 
could result in your addressees not getting your 
e-mail at all.

As for attachments, keep them to a min-
imum and small: between 50K and 2MB is best. 
In fact, e-mails with attachments that are 50K 
or less are often screened out by spam filters as 
a means of virus control. For attachments over 
2MB, check with the intended recipient before 
sending and ask for confirmation afterwards. 
Sometimes mailboxes have maximums on the 
size of acceptable attachments; others are too 
full to accept them at all.

And, a final tip: proofread your email care-
fully. Once you hit Send, that’s it! 0
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Ilene Strizver
Ilene@thetypestudio.com

Ilene Strizver, founder 
of The Type Studio, 
is a typographic 
consultant, designer, 
writer and special-
izing in all aspects 
of typographic com-
munication, from the 
aesthetic to the tech-
nical. Ilene conducts 
Gourmet Typography 
Training internation-
ally. For more infor-
mation, visit www.
thetypestudio.com.

Geoff Broadhurst

APRIL
RAFFLE
WINNER

E-mail Etiquette: Fonts and Formatting  

LIMac’s Privacy 
Policy:
General Information 
Collection: LIMac 
acquires mailing and 
e-mail addresses 
from our members 
and no other outside 
sources in order to 
communicate with 
our membership. We 
use this information 
to send out the LIMac 
Forum and to send 
occasional notices.
Disclosure to Third 
Parties We do not 
disclose mailing 
addresses, e-mail 
addresses or any 
other confidential 
information to third 
parties.
Questions If you 
have any questions 
concerning LIMac’s 
Privacy Policy, please 
e-mail them to about-
limac@aol.com. 0

the desktop or a Finder window (kind of greedy, 
aren’t you)? Then try this little trick: Control- 
click on the file you want to print to bring up a 
contextual menu. Now just choose Print from 
the menu. Once you choose it, it will either 
start printing or take you directly to the default 
application’s Print dialog.
Focusing your searches
By default, Spotlight pretty much searches 

everything on your Mac, from songs to e-mail, to 
contacts and System preferences. It’s annoyingly 
thorough (if it were human, it would make a great 
book editor). Anyway, if there are certain areas 
you don’t need it to search (for example, if you 
don’t want it rummaging through your songs), 
you can tell it what to search through and what 
to ignore. You do this by first going to Spotlight’s 
Preferences. Just click on the Spotlight icon 
in the menu bar, type a search word, and from 

the bottom of the list of found items choose 
Spotlight Preferences. When the dialog appears, 
turn off the checkboxes for the areas you don’t 
want searched.
Super shortcut to having an app load at login
If you’d like a particular application to open every 
time you log into (or start up) your Mac, now all 
you have to do is Control-click (or click-and-hold) 
on the application’s Dock icon and choose Open 
at Login from the pop-up menu.

Now restart your Mac and the application 
will launch automatically. If you want to hide the 
application after it automatically launches (so 
it stays hidden from view until you click on it in 
the Dock), here’s how: Go under the Apple menu 
(or to the Dock) to System Preferences. In the 
System Preferences pane, click on the Accounts 
icon, then in the Accounts pane, click on the 
Login Items tab. Now click on the Hide checkbox 

(Continued from Page 4)

(Continues on Page 6)
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| Adam and Tonya Engst of TidBITS are 
continuing their sixteen years of supporting 
user groups with a special 10% discount for all 
orders in their new Take Control electronic 
book series. Take Control e-books provide 
highly practical, tightly focused, inexpensive 
help from leading Macintosh authors. Titles are 
delivered in PDF layout with active links, and 
are optimized for viewing and printing. The 
user group code to take advantage of this gen-
erous offer is CPN31208MuG. (www.takecon-
trolbooks.com)
| (MYOB)Do you own or work in a Mac-based 
small business that has grown out of its com-
puterized checkbook? Have you grown tired of 
creating invoices using InDesign or Word? If 
you think you are ready to move beyond your 
shoebox, MYOB has the right tool for you at a 
great MuG discount. MYOB uS, Inc., the leader 
in Mac small business management, has just 
released MYOB Firstedge, a new Mac only 
product that will help you run your business 
quickly and easily. MuG members get $25 off 
the regular price of $99 on First edge or $100 
off Accountedge. (www.myob.com/us/)
| Actoris Software’s Xpress Schedule is the 
Macintosh tool for preparing employee work 
schedules. Create better schedules in less time, 
print schedules and even send them to your staff 
by e-mail or text message. Food Cost Manager is 
a complete back office solution for food service 
businesses. Manage your inventory, calculate 
recipe and menu costs, and prepare nutritional 
information for your customers. Xpress Schedule, 
regularly $99, is available for a special Apple 
user Group price of $74, and Food Cost 
Manager, regularly $249 is available at $185, 
that s a 25% discount. Get the user group order 
form at www.actorissoftware.com/mug and then 
e-mail your order to sales@actorissoftware.com.
| Protect your MacBook or MacBook Pro by 
choosing from any combination of Case-mate 
products. Immediately available items include: 
innovative Handle that doubles as a passive heat 
sink, regularly $50; sleek leather Sleeve, regu-
larly $89-$99; luxurious leather Suit, regularly 
$149-$159; Glovez thoroughly modern neo-
prene laptop cases, regularly $25-$29. These 
Case-mate products make your laptop more 
convenient to carry and easier to use, all while 
protecting it from dirt, dust and scratches. user 

group members receive 20% off any Case-mate 
product by using the coupon code wizard2. 
This offer is valid through May 31, 2007. (www.
case-mate.net)
Speck has become a dominant market leader in 
the iPod, MacBook, smart phone, cell phone 
and satellite radio accessory category, selling 
spirited, fun and unique products. Speck’s spe-
cial deals for group members include MacBook 
SeeThru 15”, clear or red (Core Duo version 
only) at $25.00, regularly $49.95; iPod Video 
(60gb/80gb) SeeThru (3-pack of clear, black, 
red)at $15.00, regularly $29.95; iPod nano 1G 
Canvas Sport (pink, black, white) for $12.00, 
regularly $14.95; iPod nano 1G ToughSkin 
(clear, black) at $12.00, regularly $14.95. Go to 
www.speckproducts.com/aug-specials.html to 
directly access these special items. user group 
members also get an additional 15% off online 
items whenordering from speckproducts.com 
by using the code:APPLEUSERS during check 
out. This offer is valid through May 31, 2007. 
(www.speckproducts.com)
| TopXNotes has evolved from a simple replace-
ment for Apple’s Notepad into a modern note 
organizing system. Its unique features include 
MultiView, the ability to view many notes at 
once, and a sliding toolbar that keeps text con-
trols above where you type. NoteOrganizer is 
an advanced table-of-contents with user-
defined categories/groups. The most popular 
benefit is instant desktop access via QuickNotes 
to your critical information. TopXNotes also 
includes automatic backups, unlimited Undo, 
Find and note-encryption to keep sensitive 
information safe.(user group members receive 
a 25% discount by purchasing TopXNotes for 
$22.50, regularly $30.00, or TopXNotes iPod for 
$26.25, regularly $35.00 at their Web site by 
using the coupon code uGSpecial. This offer is 
valid through May 31, 2007. (https://secure.
tropic4.com/index.shtml)
| CJRTOOLS ebooks publishes easy-to-use 
guides to Mac OS X 10.4 software, including 
Safari, Mail, System Preferences and TextEdit. 
The e-book’s features include screenshots to 
help readers understand important concepts, 
appendices with additional resources, non-
encrypted PDF downloads and free updates. 
usually priced between $7 and $8, Apple user 
group members qualify for a 20% discount on 
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next to the application’s name. 
Close the dialog and your 
application’s set.
Narrowing your search:

 give Spotlight a hint
If you want to narrow your search right off the bat, 
you can add a category when you type the term in 
the Search field.

For example, if you’re looking for a song 

named “Vertigo” (by the band U2), there’s no 
sense in having Spotlight bring you a list of e-mail 
messages from your ear doctor, right? So if you 
give Spotlight a hint as to what you’re looking for, 
you can get just songs as your Spotlight search 
results. Here’s how: Type “kind:music” (with no 
space in between or quotations), then add one 
space and type “Vertigo” (again, you don’t need 
the quotes). So your search will look like this: 
kind:music Vertigo. Now it will only search songs, 

and you’ll only get song results. Schweet!
Drag-and-Drop Desktop Printing
Want the ability to print a document right from 
your desktop (without opening the application 
first)? Go under the Apple menu, under System 
Preferences, and choose Print & Fax. When the 
preference pane appears, click on the Printer 
Setup button, and when the Printer Info dialog 
appears, press Command-L to show the Printer 
List dialog.

Your printer will appear in this dialog. Click 
on it, then go up under the Printers menu (in the 
menu bar) and choose Create Desktop Printer. A 
standard Open/Save dialog will appear asking 
you where you want to save it (I save mine on the 
desktop). Click Save and an icon for your printer 
will appear on the desktop. To print a document, 
just drag-and-drop it on this icon. Some docu-
ments, such as TextEdit files and PDFs, will go 
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Moving to digital 
audio:
By Christopher Breen 
(mac911@macworld.
com)
Q: A reader seeks 
a tool to help him 
make the transition 
from analog audio to 
digital. He writes: “I 
have a large collec-
tion of reel-to-reel 
tapes that I would 
like to transfer to 
my computer. I tried 
Griffin Technology’s 
Final Vinyl software, 
but found that it 
didn’t recognize 
blank space, with 
the result that I got a 
single file of six hours 
of music. Editing 
such a file is too 
time-consuming to 
contemplate. Do you 
know of any software 
that will recognize 
blank space to make 
file separations such 
that separate songs, 
albums, or classical 
music pieces could 
be easily transferred 
to new, smaller 
folders or music 
libraries?”
A: Sure. You can 
approach this a 
couple of ways. You 
can use an applica-
tion that, while it 

captures audio, 
attempts to create 
separate song files 
when it recognizes 
gaps. Or you can 
capture everything 
in one long file, as 
you’ve done, and 
then use a program 
to automatically 
chunk it into pieces 
after the fact.

Rogue Amoeba’s 
$32 Audio Hijack 
Pro can record 
audio from any 
source, including 
the Mac’s internal 
sound as well as 
audio you bring in 
from the outside 
via an audio input 
source (the Mac’s 
microphone port or a 
USB audio interface, 
for example). It 
includes a Silence 
Monitor feature 
that seeks out gaps 
and creates a new 
audio file whenever 
it finds one. You 
can customize the 
Silence Monitor so it 
looks for particular 
audio levels (-30dB 
for example) and gap 
lengths (1.5 seconds, 
for instance).

If you have a copy 
of Roxio’s Toast 
Titanium, you can use 
its CD Spin Doctor 
II to do something 
similar. Like Audio 
Hijack it will record 
audio from an input. 
It can’t, however, 
split it on the fly. 
Instead, it saves it as 
a single file and then 
you ask it to define 
gaps based on where 
it detects silence. 
You can adjust split 
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Give to LIMac by searching the Internet.
LIMac has just been registered on GoodSearch, 
as seen in Oprah magazine, ABC News, The 
New York Times, Wall Street Journal, 
uSA Today, and Fortune.

There is a search engine called Goodsearch.
com that donates 50% of its revenue to charities 
and schools designated by its users. LIMac is 
now a member – and Goodsearch will donate to 
us about one cent for every search our members 
make via GoodSearch.

A penny does not sound like a lot, but the 
site is all about numbers. How much money is 
raised will depend on how well we can spread 
the word to our members – the more LIMac 
members use Goodsearch for their Internet 
searches, the more money we will raise. 200 of 
us searching four times a day will raise about 
$2,433 in a year without anyone spending a 
dime!

Think of all the money that could be raised 
while you and your friends and family are 
surfing the Web at www.goodsearch.com!

Come to the April meeting and find out 
more about GoodSearch. 0
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(Continued from Page 6)
straight to the printer. Other files will launch their 
default application and open the Print dialog.
Making ZIP files (compressed Files) in a click
One of my favorite Mac OS X features is the 
ability to create ZIP compressed files from 
within the OS (basically, this shrinks the file size, 
ideal for files you’re going to e-mail — smaller 
file sizes mean faster file transfers). To create 

a compressed file, either Control-click on the 
file and choose Create Archive (which is Apple-
speak for “make a compressed ZIP file”). Or you 
can click on a file, then go to the Action menu 
(the button that looks like a gear up in the Finder 

window’s toolbar), and choose 
Create Archive from there. Either 
way, it quickly creates a new file, 
with the file extension “.zip.” This 

is the compressed file. You can also compress 
several different files (like three, for example) 
into one single archive file — just Command-click 
(or Shift-click contiguous files) on all the files you 
want included, then choose Create Archive of X 
Items from the Action menu. A file will be created 
named “Archive.zip” (that’s it!). 
Speed Tip:  When you’re looking for files in either 
List view or Column view, some of your files with 

long names will have some letters cut off from 
view. Here is a tip that will save you from having 
to resize your columns — hold your cursor over 
the file’s truncated name for a few seconds and 
eventually its full name will pop up. Instead, hold 
the Option key, then put your cursor over the file’s 
name, and its full name will appear instantly. 0

Send your $36 check to: 

LI Macintosh Users Group, 

P.O. Box 2048 

Seaford, NY 11783-0180

I

to iPhoto’s Preferences… select the Advanced 
category and un-check the option to Copy files 
to iPhoto Library folder, but of course you can 
never rename or move and certainly not delete 
these files you dragged into iPhoto under these 
conditions, as iPhoto will not be able to find 
them if you do. Also never go mucking around 
in the iPhoto Library folder’s contents or sub-
folders. If you want to make copies of some 
images, it’s probably best to drag them to a new 
folder on the Desktop from the iPhoto window. 
You can also select Export… from the File menu 
to make copies of a selection of pictures. 
| How can I protect an external hard drive so 
no one can copy data off of it? 
You can keep private data within a password-
protected disk image stored on the hard 
drive. It requires no special software, it’s free 
and the disk image can be stored on a FAT32 
MS-DOS-formatted drive, so it can work cross 

platform. From the File menu, select New, and 
then Blank Disk Image… Select a name (I 
used “expand-me-to-500 MB”, avoid spaces 
if this going to be on a MS-DOS-formatted 
drive. Specify a location, a maximum size (for 
example a sparse volume that can grow to 500 
MB initially takes up 18.1 MB on disk but shows 
484.1MB available for files), select AeS-120 
from the Encryption pop-up and choose sparse 
disk image from the Format pop-up and then 
click Create. Then specify a password, twice, 
don’t save the password in a keychain and 
click OK. It will create the .sparseimage file and 
mount it on the desktop. Copy your private files 
to the mounted volume. When finished for now, 
eject the mounted volume. When you need it 
again, double-click on it, enter the password in 
the dialog box that pops up (again don’t have 
it remember the password), it mounts on the 
desktop and you can drag more stuff to the 
mounted volume or delete whatever you need 
from it. empty the trash if you do delete stuff. 
You will find that the .sparseimage file does not 
really compress if you delete most everything 
back to the original file size. You can use the 
free FreeDMG 0.54b which has a Compact… 
menu choice from it’s Images menu to shrink 
it back to a reasonable size. You can also use 
FreeDMG to resize the maximum permitted 
size for the sparse disk image. It can change the 
password, too. The only problem with this plan 
is the .sparseimage file itself can be deleted out 
of frustration by someone after your encrypted 
data. You can try turning off the Ignore own-
ership on this volume option in the Get Info… 
window for the drive and thus any other user 
should not be able to delete the file, as it should 
be read only for guests. Of course they would 
not be able to erase any other file on the drive 
besides the .sparseimage file. 0

Send your $36 check to: 
Long Island Macintosh Users Group, P.O. Box 2048,

 Seaford, NY 11783-0180

points and add your 
own. From there you 
can export the tracks 
to iTunes (exporting 
it as in AAC, MP3, 
or Apple Lossless 
format) or send them 
to Toast for burning 
to CD. CD Spin Doctor 
II isn’t the most accu-
rate tool I’ve used for 
detecting gaps after 
the fact, however.

A more accurate 
tool is Rogue 
Amoeba’s $32 
Fission. Unlike Audio 
Hijack Pro and CD 
Spin Doctor II, Fission 
won’t record audio. 
Instead, it’s the 
tool to use when 
you already have an 
existing audio file 

– much as you do with 
your six-hour reel-
to-reel recording. 
Just open the file in 
Fission, choose Tools 
-> Smart Split, and 
Fission will guess 
where the gaps lie 
(and its first guess 
is usually pretty 
good). If the guess 
isn’t so good, adjust 
the Length (length of 
gap) and Sensitivity 
(volume determined 
to be silence) sliders 
and new suggested 
split points will be 
added or subtracted. 
When you have the 
split points you want 
(you can add some of 
your own if you like), 
click the Split button 
and Fission creates 
split points. You can 
then export the files 
in a variety of audio 

formats.
Finally, you could 

opt for a full-blown 
audio editor that has 
an option to create 
markers based on 
audio gaps. The 
audio editor I’d sug-
gest is HairerSoft’s 
$40 Amadeus 
Pro. It’s a terrific 
multitrack editor that, 
like its predecessor, 
Amadeus II, includes 
a Generate Markers 
command that can 
be used to search 
for silences (you 
can configure the 
gaps’ minimal length 
as well as maximal 
level). Impose this 
command and the 
program creates 
markers where it 
believes gaps lie. 

You can adjust 
the position of these 
markers as well as 
create your own. 
Once you’re satis-
fied with the split 
points choose Sound 
-> Split According to 
Markers and the pro-
gram does as you ask, 
letting you choose 
the audio format 
you’d like to save the 
files in. 0

Cont. from Page 6)

http://www.goodsearch.com
http://www.rogueamoeba.com/fission/
http://www.kelleycomputing.net/freedmg/index.php
http://www.goodsearch.com/Default.aspx
http://www.hairersoft.com/AmadeusPro/AmadeusPro.html
http://www.hairersoft.com/AmadeusPro/AmadeusPro.html
http://www.hairersoft.com/Amadeus.html
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all purchases placed through CJRTOOLS’ 
Kagi store (homepage.mac.com/cjrtools/ebooks/
orderebooks.html) using the discount code 
MUGD14A73C. This offer is valid through June 
30, 2007.
| Cordgo is a one-hand operated cord adjust-
ment and storage accessory. Its durable, light-
weight design fits in the palm of your hand. 
Clip it on your belt or armband, or just slip it in 
your pocket. Cordgo’s fast, easy storage saves 
you from ever having to deal with tangled 
cords again. Cordgo was designed to perform 
as an integral component between cord and 
digital device. regularly priced at $9.95, Apple 
user group members can now buy two Cordgos 
for $7.96; that’s 60% off regular price by using 
the coupon code augvd2252. This offer is valid 
through June 30, 2007. (www.cordgo.com).
| Is your iPod lacking personality? Nano just 
not impressing you by size alone? Swank it up 
with more than just new music: go ahead and 
put some hip into it with a new strap, wrap, 
bone, doggy, star, iLink, skin, iRoll, iMagnet, 
iMemory, miniMac or other accessory.
| HipIpodGear has something for every iPod 
and then some. Better yet, HipIpodGear ships 
across the globe.(Want a better deal? With the 
coupon code tire20 Apple user Group mem-
bers can receive an additional 20% off. This 
offer is valid through June 30, 2007. (www.
hipipod gear.com).
| PremiumMemory.com is a leading online 
memory provider with a commitment to supe-
rior memory products and world-class service 
and support. All Premium memory is backed 
by a lifetime warranty and made from top 
quality components. Premium maintains a 
complete inventory of compatible Mac 
memory upgrades and guarantees 100 percent 
compatibility. For all your Mac memory 
upgrades, visit Premium’s Web site and receive 
a 25% discount on all Mac compatible rAM 
upgrades purchased at PremiumMemory.com 
using the coupon code MUG-25OFF. Better 
yet, you will receive free shipping on all orders 
over $75.This offer is valid through June 30, 

2007. (www.premiummemory.com)
| Need more space for your business files, movies, 
pictures and music? A Western Digital (WD) 
hard drive is the easiest way to add extra storage. 
WD features the My Book line of external hard 
drives, Passport portable hard drives, and WD 
internal SATA II and EIDE hard drive kits. Get a 
20% discount on all products by logging on 
with an e-mail account and receiving a promo 
code that can be used for the purchase of 
anyWD hard drive. This offer is valid through 
June 30, 2007. (www.wdc.com/en/buy/partner-
store.asp).
SeeFile 3.0 is a new Mac OSX application that 
lets creative pros share their work with clients, 
using their own Mac as a Web server. SeeFile 
creates private folders for clients (each with a 
private username and password) and creates live 
thumbnails of photos, PDFs, and videos. It is 
ideal for wedding and commercial photogra-
phers, design firms, videographers and print 
providers. Specially priced at $395, user group 
members receive 20% off the list price, for the  
5-account entry version; upgrades and eCom-
merce options are available as well. Order by 
phone or e-mail with the coupon code provided. 
Order by phone: 617-262-2421; Order by e-
mail: sam@seefile.com Coupon code: AGXE. 
This offer is valid through July 31, 2007. (www.
seefile.com)
| CrossOver Mac allows you to run many pop-
ular Windows software applications on your 
Intel Mac. Your applications, documents and 
email attachments are seamlessly integrated 
into the Mac OS X. You work as you would in 
Windows, but with the freedom and ease of the 
Mac. You do it all easily and affordably, without 
needing a Windows license. CrossOver Mac 
offers user group members a special price of 
$47.96, a 20% discount off the regular price of 
$59.95. Special Code: macuser. This offer is 
valid through July 31, 2007. (https://www.code-
weavers.com/store/).
| Ovolab Geophoto is a new Mac OS X applica-
tion for browsing and collecting digital pictures 
by location. user group members can purchase 
Geophoto at the special price of $14.95, a 25% off 
the retail price of $19.95. Coupon code: 2007. 
(www.ovolab.com/geophoto/). 0
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In Preview, selecting 
Rotate from the 
Tools menu rotates 
every page of a PDF 
left or right: 
This can be a pain if 
(say) you have a 
portrait-format 
brochure which 
includes one land-
scape-format map. 
An undocumented 
feature, though, is 
that you can hold 
Option while selecting 
Tools Rotate, and this 
will rotate the current 
page only.

Shift-Tab Hides 
all Adobe palettes 
except Toolbox: 
Most designers know 
that tapping the Tab 
key is the quick way 
to temporarily hide 
all open palettes in 
Adobe Photoshop, 
InDesign or 
Illustrator. Very handy 
when your design 
is obscured by too 
many windows. Even 
more handy: Press 
Shift+Tab and you 
can keep your Toolbox 
and Options bar, 
but hide the other 
palettes!

Mac OS X Hints:
The insiders’ tips 
you won’t get from 
Apple:
Assign custom icons 
more quickly.
OS X lets you create 
custom icons for your 
files and folders, 
which is not only fun 
but also useful – you 
can, for instance, 
place a custom icon 
on all of a project’s 
folders to make them 
easy to identify at a 
glance.

You can freely 
download count-
less types of icons 
from sites such as 
The Iconfactory 
and InterfaceLift. 
Or you can use an 
icon editor, such as 
Uncommonplace’s 
Icon Machine ($25) 
or Mscape Software’s 
Iconographer ($15), 
to create your own.

The problem 
is that assigning 
custom icons is 
rather tedious. First, 
you have to click 
on the file with the 
icon you want and 
choose File: Get Info 
(Command-I) in the 
Finder. Next, you 
click on the small 
icon in the Get Info 
window and copy 
it (Command-C). 
Then you click on the 
destination file, open 
its Get Info window, 
and paste the icon 
(Command-V) 
into the right spot. 
That’s a lot of clicks, 
especially if you’re 
changing multiple 
icons.

So here’s a time-
saver (for those of 
you running OS X 

10.3.3 or later): don’t 
use the Get Info 
window when you’re 
copying the custom 
icon. Instead, just 
select the source 
item in the Finder and 
press Command-C to 
copy the icon. 

Now select the 
destination. Press 
Command-I to open 
the Get Info window, 
click on the small 
icon image, and 
press Command-V to 
paste.
– Rob Griffiths

DAN DANGLO

How to better visually 
enjoy the Forum: 
Your editor prefers you to  
use Preview (with OS X) or 
PostView (www.metaobject.
com/Products.html#PostView) 
for reading the Forum.pdf 

– excellent programs that handle.pdf files with 
more visual accuracy than Adobe Reader ! (Also 
read their Help files to discover the many tools 
and techniques they have available.) 

You’ll be happily surprised! 0

EXCELLENT!!

http://www.cordgo.com
http://www.hipipodgear.com
http://www.hipipodgear.com
http://www.premiummemory.com
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http://www.wdc.com/en/buy/partnerstore.asp
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http://www.seefile.com
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https://www.codeweavers.com/store/
http://www.ovolab.com/geophoto/
http://www.metaobject.com/Products.html#PostView
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